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Abstract 

We report on the low noise optimization of an axial fan specifically designed for the cooling of CSP power plants. The duty point 
presents an uncommon combination of a load coefficient of 0.11, a flow coefficient of 0.23 and a static efficiency ηstat > 0.6. 
Calculated fan Reynolds number is equal to Re = 2.85 x 107. Here we present a process used to optimize and numerically verify 
the fan performance. The optimization of the blade was carried out with a Python code through a brute-force-search algorithm. 
Using this approach the chord and pitch distributions of the original blade are varied under geometrical constraints, generating a 
population of over 24000 different possible individuals. Each individual was then tested using an axisymmetric Python code. The 
software is based on a blade element axisymmetric principle whereby the rotor blade is divided into a number of streamlines. For 
each of these streamlines, relationships for velocity and pressure are derived from conservation laws for mass, tangential 
momentum and energy of incompressible flows. The final geometry was eventually chosen among the individuals with the 
maximum efficiency. The final design performance was then validated through with a CFD simulation. The simulation was carried 
out using a RANS approach, with the cubic k -  low Reynolds turbulence closure of Lien et al. The numerical simulation was able 
to verify the air performance of the fan and was used to derive blade-to-blade distributions of design parameters such as flow 
deviation, velocity components, specific work and diffusion factor of the optimized blade. All the computations were performed in 
OpenFoam, an open source C++- based CFD library. This work was carried out under MinWaterCSP project, funded by EU H2020 
programme. 
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1. Introduction 

To be written 

2. Optimization 

Numerical design optimization was used to minimize the trailing edge noise of a single stage axial fan. Two 
geometric variables were varied (chord and pitch distribution) in order to provide a wide database of optimized 
individuals that can be used to search for solutions that can satisfy different geometrical constraints a posteriori 
selected. Imposed constraints assured the same total pressure rise delivered from the baseline fan. A blade element 
model was used to evaluate the aerodynamic performance of the fan and trailing edge noise. One potential design was 
selected from the set of simulations and the comparison with the baseline blade showed that it is possible to obtain an 
individual that both can reduce noise generation and increase the total to total efficiency. 

 
Nomenclature 

ch chord length   [m]  Q volume flow rate   [m3/s] 
 ξ pitch angle   [deg]  Cx mean axial velocity  [m/s] 
Nref  number of reference sections [-]  cax axial velocity   [m/s] 
K number of nodes   [-]  U rotation velocity   [m/s] 
SPL sound pressure level   [dB]  w relative velocity   [m/s] 
ψ load coefficient   [-]  β flow angle   [deg] 
φ flow coefficient   [-]   deflection   [deg] 
ηtot,stat total static efficiency  [-]  W specific work   [J/Kg] 
ptot,stat total static pressure  [Pa]  DF diffusion factor    [-] 

 

2.1. Methodology 

The most relevant noise source in the baseline fan is produced by the trailing edge. Trailing edge noise is caused by 
the vorticity shed from the trailing edge which produces local lift fluctuations. In the present study, a model for the 
trailing edge noise was combined with an aerodynamical model for rotor-only fans. For a given rotor geometry and 
fan operating conditions, the analysis tool provided the trailing edge noise and flow characteristics (e.g., velocity 
triangles, fan efficiency and pressure rise).Numerical model used for the generation of the database is implemented in 
AxLab, a tool for performance analysis of ducted axial fans. This software is based on a blade element axisymmetric 
principle. The rotor blade is divided into a number of streamlines. For each of these streamlines relations for velocities 
pressure are derived from incompressible conservation laws for mass, tangential momentum and energy. The 
complexity of 3D flow is partially reproduced by the juxtaposition of the flow conditions on the meridional plane and 
the circumferential plane. The analysis model for the noise emission is based on the model developed by Fukano et al 
[ref]. 

 

2.2. Description of the baseline blade 

The baseline blade is a single stage axial fan for cooling of CSP power plants.The duty point of baseline blade 
presents an uncommon combination of dimensionless global duty parameters: a load coefficient of 0.11, a flow 
coefficient of 0.23 and a static efficiency > 0.6. Airfoil thickness distribution used for each section is an optimized 
version of NASA LS 417 distributed on a circular arc camber line. Geometry of the baseline blade is represented 
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inside AxLab software by means of eleven radial  blade sections. Following charts report performance data evaluated 
by Axlab. In Figure 1 are presented values of dimensionless global duty parameters and static efficiency. 

 
 
 
 
 

 

2.3. Pitch and chord optimization 

Optimization process take into account both variation in pitch angle and blade chord of each section of the blade. In 
order to identify the variation of pitch and chord distributions, the following methodology was selected: 
 

 Along the blade span are identified a number of reference sections Nref ; 
 On each of those sections, values of pitch and chord are selected on an arbitrary number of nodes K . 
 Pitch and chord distributions are forced to have values indicated on values of nodes K in correspondence of 

the prescribed reference section. Final distribution to be tested will be approximated by a polynomial 
function ξ (R) where deg(ξ) will be equal to Nref-1. 

In particular, during pitch optimization were selected 6 reference sections and for each of those section 7 nodes. Nodes 
were selected considering a pitch variation of the baseline configuration of +/- 30%, +/- 20%, +/- 10% and 0%. Instead 
for the chord length optimization were selected 5 reference sections and for each of those 6 nodes considering a chord 
variation of the  configuration of the baseline configuration of + 30%, +/- 20%, +/- 10% and 0%  for the first two 
reference sections while for the rest - 30%, +/- 20%, +/- 10% and 0% (see Figure 2). In order to avoid excessive 
distorted or unrealistic geometries we decided to insert following criteria:  
 

1. Decreasing pitch: ξ (Ri) < ξ (Ri+1>RA); 
2. Limited pitch distortion: ξ (Ri) - ξ (Ri+1) < 8°; 
3. Limited chord distortion: lc (Ri) - lc (Ri+1) ≤ 0.1 m; 
4. Weight limit: wBaseline blade < wIndividual. 

 
Application of constraints 1-4 brings the number of individuals from ~ 6×1011 to 206275 reducing the computational 
cost at 2/1000 of the total. Blade weight was simply evaluated numerically integrating the chord length across the 
blade span, considering a linear thickness distribution from 13% to 9%. Each simulation was run with AxLab on a 
Linux server using 40 processors and the total computational time was of about 7 days. The software evaluates every 

Figure 1 - static efficiency ηstat and load coefficient ψ vs flow coefficient φ 
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geometry. If the total pressure rise provided results different from the imposed value, hub pitch (ξ hub) of the blade is 
modified in order to obtain the target value with an error of 0.1% on total pressure rise.  

 
All tested configuration were stored into a database: each element is identified by values of gain in terms of total 
efficiency Δηtot and gain in sound pressure level ΔSPL. In Figure 3(a) are presented results from the database for all 
tested configuration. Again a detail of Figure 3(a) is provided into Figure 3(b) in order to have an insight in the region 
of interest of the database. 

Results demonstrate that a notable noise reduction and efficiency increase can be obtained. Even if it is difficult to 
clearly identify a selection of optimal solutions (e.g. a Pareto Front), one element was selected from all the data 
following the main goal of increasing ηtot and to decrease as much as possible SPL. Table 1 reports the main features 
of candidate. 

Table 1- Selected individual features in terms of static efficiency and noise emission 

Individual name stat [%] SPL[dB] stat[%] SPL[dB] hub [deg] 
Optimized blade 64.003 95.630 2.783 -1.9745 -2.767 

Figure 2 -  Range of chord length variation with evidenced reference sections Nref  and nodes K 
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Figure 3 - Database of simulations performed during pitch and chord optimization; (b) detail of figure 3(a) 
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The first result of this optimization process is that Opt II element reduced the blade weight of 10% and incremented 
the fan static efficiency more than 2%. Also results on blade noise emission seems to be promising. 

 

3. CFD  

Here a comparison between the new blade design with the datum, especially in term of static pressure and static 
efficiency is performed. Due of the lack of experimental data, a validation of the CFD simulation has not been possible. 
The same numerical approach, however, has been successfully applied for the prediction of the duty point performance 
of the datum, as shown in  Table 2. 

 

        Table 2 - Datum blade CFD results vs experimental 

 
 
 

 

3.1. CFD Details 

Computations were carried out with the C++ open-source code OpenFOAM 2.3.x using the simpleFoam solver for 
steady computations of incompressible flows. The Generalized Algebraic Multi-Grid solver was used for pressure, 
while all the other equations were solved with a smoothSolver. Convergence threshold was set to 10-7 for pressure and 
to 10-5 for the other quantities.  Turbulence modelling relied on the low-Reynolds cubic model of [ref]. The model 
solves two transport equations for k and . 

 

3.2. Grid details, computational domain and boundary conditions 

 The computational domain entails one blade-to-blade passage, with periodic boundary conditions imposed at mid-
pitch. The domain extends 1 chord up- and 1.5 down-stream of the blade leading and trailing edge. The computational 
grid, Figure, entails 10.5M hexahedra clustered along the endwalls and the blade profile. The mesh has 400 cells on 
the blade surface and 240 cells in the endwall to endwall direction, 30 of which are in the tip clearance. Mesh quality 
indicators are summarized in Table 3. The low skewness of the mesh was achieved using periodic boundaries with 
Arbitrary Mesh Interface technology. The inflow mass flow was specified, with a level of turbulence equal to 5%. At 
the outlet of the domain convective boundary conditions were specified. Over solid the upper endwall velocity was 
imposed equal to zero, and for the blade and the lower endwall velocity was imposed coherently with the full speed 
of the fan. k and  were set to zero over all the solid walls following a well-known redefinition of the  equation. 

 

 Experimental CFD Error [%] 
p [] 0.09323 0.08712 0.065 

s [-] 56.0 57.76 0.031 

 Minimum Maximum Average 
Volume ratio 1 4.8 1.1 
Aspect ratio 1 160 9.7 
Skewness 0 0.61 0.12 
Min. included angle 23.5 90 63.5 
y+ 0.67 5.2 2.77 

Table 3 - Mesh quality and y+ values 

Figure 4 - Detail of the computational grid at the junction 
between blade and endwall 
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4. CFD Results 

Computations were performed for 40000 iterations, until the full convergence of pressure and blade torque. A good 
match between the 3D simulation results and the synthetic model numerical approach has been found, at least for most 
of the span of the blade. Near the upper endwall, where the leakage vortex causes a fully three-dimensional 
development of the flow, CFD simulation was able to better represent fluid physic. Here we show a comparison 
between AxLab and CFD results. 

 

4.1. CFD vs AxLab 

The span-wise analysis of some flow characteristics is shown in Figure 5. As expected, the main mismatch between 
the synthetic and the fully three-dimensional approach relies in the representation of the flow close the upper and the 
lower endwalls. Axial velocity distribution appears to follow the same trend in the synthetic analysis, while the CFD 
fields show a deficit due of the tip leakage vortex. The inf and  graphs reveals an aerodynamic unloading of the 
lower sections, also witnessed by the DF distribution. The CFD matched such behavior. Benefits of this unloading are 
clearly known both for efficiency and noise reduction, while the differences detected in work and 2 angle distributions 
are found to be almost inconsistent. Specific work is moved through the tip of the blade. 
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4.2. Mean Flow Properties 

The analysis of velocity field is the proof of the effectiveness of the optimization procedure. Flow is fully attached 
to the blade along all the blade span, without phenomena of recirculation, as highlighted by Figure [fig]. Velocity 
fields reflects specific work distribution. A further analysis can be performed through the helicity visualization, which 
reveals some key aspects on the flow (Figure [7]). The most prominent feature is constituted by the presence of a 
turbulent structure close to the hub of the blade, occupying the first 15 % of the blade span. Here, the high magnitude 
of helicity can be attributed to the corner vortex caused by the junction between the hub of the blade and the lower 
endwall. Higher values of helicity can also be observed in a small region close to the upper endwall, where the tip 
leakage vortex is strongly clustered to the wall. At approximately the 70 % of the blade span a region of medium 
helicity, caused by the flex in the chord distribution of the blade. 

  

Figure 6 – Normalized velocity fields for different span percentages (a) 10%; (b) 50%;  (c) 98% 

Figure 7 – Helicity field at 0.5c from the t.e. of the blade 
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4.3. Tables 

All tables should be numbered with Arabic numerals. Every table should have a caption. Headings should be placed 
above tables, left justified. Only horizontal lines should be used within a table, to distinguish the column headings 
from the body of the table, and immediately above and below the table. Tables must be embedded into the text and 
not supplied separately. Below is an example which the authors may find useful. 

     Table 1. An example of a table. 

An example of a column heading Column A (t) Column B (t) 

And an entry 1 2 

And another entry 3 4 

And another entry 5 6 

4.4. Construction of references 

References must be listed at the end of the paper. Do not begin them on a new page unless this is absolutely 
necessary. Authors should ensure that every reference in the text appears in the list of references and vice versa. 
Indicate references by [1] or [2] or [3] in the text.  

Some examples of how your references should be listed are given at the end of this template in the ‘References’ 
section, which will allow you to assemble your reference list according to the correct format and font size. 

4.5. Section headings 

Section headings should be left justified, bold, with the first letter capitalized and numbered consecutively, starting 
with the Introduction. Sub-section headings should be in capital and lower-case italic letters, numbered 1.1, 1.2, etc, 
and left justified, with second and subsequent lines indented. All headings should have a minimum of three text lines 
after them before a page or column break. Ensure the text area is not blank except for the last page. 

4.6. General guidelines for the preparation of your text 

Avoid hyphenation at the end of a line. Symbols denoting vectors and matrices should be indicated in bold type. 
Scalar variable names should normally be expressed using italics. Weights and measures should be expressed in SI 
units. All non-standard abbreviations or symbols must be defined when first mentioned, or a glossary provided. 

4.7. File naming and delivery 

Please title your files in this order ‘procedia acronym_conference acronym_authorslastname’. Submit both the 
source file and the PDF to the Guest Editor. 

Artwork filenames should comply with the syntax “aabbbbbb.ccc”, where: 
 a = artwork component type 
 b = manuscript reference code 
 c = standard file extension 
Component types: 
 gr = figure 
 pl = plate 
 sc = scheme 
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 fx = fixed graphic 

4.8. Footnotes 

Footnotes should be avoided if possible. Necessary footnotes should be denoted in the text by consecutive 
superscript letters1. The footnotes should be typed single spaced, and in smaller type size (8 pt), at the foot of the page 
in which they are mentioned, and separated from the main text by a one line space extending at the foot of the column. 
The Els-footnote style is available in the MS Word for the text of the footnote. 

Please do not change the margins of the template as this can result in the footnote falling outside printing range. 

5. Illustrations 

All figures should be numbered with Arabic numerals (1,2,3,….). Every figure should have a caption. All 
photographs, schemas, graphs and diagrams are to be referred to as figures. Line drawings should be good quality 
scans or true electronic output. Low-quality scans are not acceptable. Figures must be embedded into the text and not 
supplied separately. In MS word input the figures must be properly coded. Preferred format of figures are PNG, JPEG, 
GIF etc. Lettering and symbols should be clearly defined either in the caption or in a legend provided as part of the 
figure. Figures should be placed at the top or bottom of a page wherever possible, as close as possible to the first 
reference to them in the paper. Please ensure that all the figures are of 300 DPI resolutions as this will facilitate good 
output. 

The figure number and caption should be typed below the illustration in 8 pt and left justified [Note: one-line 
captions of length less than column width (or full typesetting width or oblong) centered]. For more guidelines and 
information to help you submit high quality artwork please visit: http://www.elsevier.com/artworkinstructions 
Artwork has no text along the side of it in the main body of the text. However, if two images fit next to each other, 
these may be placed next to each other to save space. For example, see Fig. 1. 
 

 

Fig. 1. (a) first picture; (b) second picture. 

6. Equations 

Equations and formulae should be typed in MathType, and numbered consecutively with Arabic numerals in 
parentheses on the right hand side of the page (if referred to explicitly in the text). They should also be separated from 
the surrounding text by one space. 

 

 
1 Footnote text. 



10 Author name / Energy Procedia 00 (2017) 000–000 

   

























P
E

E
PTJ

E
m

C

C 1const.




     (1) 

4. Online license transfer 

All authors are required to complete the Procedia exclusive license transfer agreement before the article can be 
published, which they can do online. This transfer agreement enables Elsevier to protect the copyrighted material for 
the authors, but does not relinquish the authors’ proprietary rights. The copyright transfer covers the exclusive rights 
to reproduce and distribute the article, including reprints, photographic reproductions, microfilm or any other 
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permission to reproduce any figures for which copyright exists. 
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Instructions to Authors for Word template 

1. Locking of Copyright: 

The copyright line is locked in the Procedia templates. The author may not edit the same and making it editable 
only PSMs. If there are any copyright changes required, you are requested to contact Journal Manager through Guest 
Editors. For editable the below mentioned steps must be followed: 
 
Steps: 

 Click on copyright statement 
 Click on Properties in Developer tab 
 Remove the checks from Content control cannot be deleted and Contents cannot be edited under Locking 

and then Press ok 

2. Docm format: 

We have added macros in the Word templates for the below mentioned features. And since macros are not 
supported in doc and docx format we created the templates of all Procedia titles in .docm format. 
 

 Removal of all highlights 
 Accept track change 
 Locking of Rules 

 
If .docm format needs to convert in docx format then the following steps must be performed: 

 
Steps: 

 Press Alt  F11 
 Click on Project (JID_Template) 
 Enter "thomson" in Project Password 
 Click on Microsoft Word Objects 
 Click on ThisDocument under Microsoft Word Objects 
 Delete all macros under General 
 After deletion close the Code and Project (JID_Template) windows 
 From File menu click on save as type .docx option  

3. Comments added in the margin in Word master templates: 

There are instances where author raising queries on what to do with key information lines such as “volume, page 
numbers”, “Conference title per issue” and “Copyright entity, year, copyright company Elsevier Ltd./B.V./Inc. and 
Organizer Name” in the copyright statement and for these concerns the comments have been inserted in the Word 
template to guide Author/JM about the information to be inserted by them in these fields.  

Comments removal from Print: In Word 2007 and 2010 the comments present in a document get printed by default. 
If the authors do not want to get the comments appearing in print, the authors must remove the comments from the 
Word template before printing by changing the Print markup setting of word using the following steps: 

Steps: 
 Click the File tab 
 Click Print 
 Under Settings, click the arrow next to Print All Pages 
 Click Print Markup to clear the check mark  
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Instructions to Authors pages to be excluded from Print:  
 Click the File tab 
 Click Print 
 Under Setting, Type page numbers and/or page ranges separated by commas counting from the start of the 

document or the section. For example, type 1, 3, 1-5  

4. PDF creation from Word master template:  

While creating PDF from Word template the below given steps should be followed to avoid difference in trim size 
and margins and to avoid decrease in resolution and size of the figure images of the Word template and the PDF 
created. 
 
Steps in Word 2007 and 2010: 

 Click the File tab 
 Click Print 
 Under Printer tab, select Adobe PDF  
 Click Printer Properties link 
 Under Adobe PDF Settings tab, click on Edit button 
 Click on Images folder under Standard 
 Make Downsample and Compression fields under Color Images and Grayscale Images "Off". And in 

Monochrome Images field make only Downsample "Off' 
 Then click on OK and given name of the setting in File name tab and click on save 
 Then again Under Adobe PDF Settings tab, click on Edit button 
 Then click on Color folder  
 Choose Leave Color Unchanged option under Color Management Policies tab then click on OK 
 Lastly click on OK in Adobe PDF Settings tab 
 Click Save As 
 Under Save as type, click the arrow next to PDF (*.pdf) 
 Click Save 

 
In Word 2003 the PDF can be created by using “Convert to Adobe PDF” symbol in tool bar or the required paper 

size can be adjusted in the Adobe PDF settings given in the Properties tab on the Print option. Please follow the above 
steps to avoid decrease in resolution and size of the figure images.  
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